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Introduction 
This document assumes you are familiar with the concept of usability testing. If youôre new to usability testing, 
start with Usability Testing Basics which explains the basics of usability testing, including information about 
how to figure out what to test, when to test, and how to test. Usability Testing Basics is available on the 
Morae Resource CD and in the Morae Learning Center (http://www.techsmith.com/learn/morae/default.asp). 

Hardware or Mobile Device Usability Testing with Morae 

Are you building things people merely tolerateéor things they love? Whether itôs a mobile phone, GPS unit, 
or an espresso machine, you can improve the design by testing it in the hands of real customers. 

Watch customers manipulate physical buttons and navigate on-screen menus. Capture their body language, 
verbal comments, and success rates. Use Moraeôs complete toolset to log, analyze, and present the data. 

For a hardware or mobile device usability test, Morae can record from one or two cameras. With two cameras, 
you can record close-up video of the hardware or device, along with camera video of the user.  

This document provides the following: 

 Set Up the Test 

 Record and Log Test Sessions 

 Analyze and Present Findings 

 How to Retrieve Your Key Measures from Morae 

The document also contains the following appendices: 

 Appendix A: User Research Request 

 Appendix B: Test Protocol Document 

 Appendix C: Example Usability Test Report 

 Appendix D: Usability Test Checklist 

http://www.techsmith.com/learn/morae/default.asp
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Hardware or Mobile Device Usability 
Testing Considerations 
Similar to software or Web usability testing, the goal of hardware or device testing is to measure the efficiency, 
effectiveness, and satisfaction of the use of a hardware product or device by having users perform real-world 
tasks with the product.  

Because the device or hardware and the participantôs interactions with it with it will be recorded using a 
camera, consider carefully what cameras, lighting, camera locations, and mounting hardware are needed to 
record the activity.  

Because screen recording data will not be available, prepare your markers carefully to ensure that observers 
or the person logging on the recording computer will note events such as: 

 Task start and end times 

 The actions the participant takes (buttons clicked, menu items chosen) 

 When a mistake or error is made 

 Comments and quotes of the participants 

 Observations of facial expressions and body language, etc. 

Procedure 

The test must be conducted in your lab (which can be as simple as a room with a computer and Web cam) or 
face-to-face at an off-site location. These tests cannot be conducted remotely using UserVue because the 
participant will be working directly with an artifact (hardware or a device), similar to paper prototype testing.  

Also like paper-prototype testing, the device or hardware and the participantôs interactions with it with it are 
recorded using a camera. A second camera can also be used to record participantôs face with a Web cam via 
Picture-in-Picture.  

Use the default configuration provided for paper prototype testing in Morae to record the test. Because there 
will be no screen recording used, the recording computer can also be used to log test data during the test by 
the facilitator or an assistant; consider having the facilitator log the test on the recording computer. Remember 
you may need to flip your camera while recording to make the prototype view properly in the recording. 
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Set Up the Test 
Use the steps in this section to to set up the test in Morae Recorder. For more information on usability test 
planning, see Usability Testing Basics, available on the Morae Resource CD and in the Morae Learning 
Center 

 

To set up a test in Recorder: 

1. Create a Study Configuration 

2. Define the Scenario 

3. Define Tasks 

4. Define Markers 

5. Define Surveys 

6. Save Study Details 

7. Configure Recording Details 

8. Complete Test Set Up 

 This document walks through this process at a high level. You can find more information on the full 
procedures and options in the help included in the Morae components or find both video and written 
tutorials in the Morae Learning Center: http://www.techsmith.com/learn/morae/default.asp.  

1. Create a Study Configuration 
A study is a group of test sessions where participants complete the same tasks. In Morae, a study 
configuration file (.mrcfg) defines all test-specific information. This includes the scenario, tasks, markers, and 
surveys. 

You use the same study configuration to record each of the test sessions. Only recordings with the same 
study configuration can be later searched and graphed together in Morae Manager.  

Morae Recorder includes template study configurations to help you define study configurations for different 
kinds of studies. Templates contain sample tasks, markers, and surveys, along with pre-configured 
Recording Details which define how to record the session. 

http://www.techsmith.com/learn/morae/default.asp
http://www.techsmith.com/learn/morae/default.asp
http://www.techsmith.com/learn/morae/default.asp
http://www.techsmith.com/learn/morae/default.asp
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When you open Recorder, create a new study configuration based on Hardware or Mobile Device Study. 
When you click OK, the template study configuration opens in Recorder. 

 

 

2. Define the Scenario 
A scenario gives the participant the background to complete the tasks. It tells them why they are doing the 
tasks and any introductory information they may need to complete the task. 

The scenario should be realistic and allow the participant to relate to the situation. For more on how to create 
a scenario, see Usability Testing Basics, available on the Morae Resource CD and in the Morae Learning 
Center. 

For example, to find out how users interact with your company web site, the scenario may be:  

You will perform up to 4 different tasks using a cell phone. 

You have just purchased a new cell phone and want to personalize it. Follow the instructions for each task 
and then perform the task as you would if you were actually doing this task for yourself.  

Please talk out loud while you work, and keep a running dialog of your thoughts, actions, expectations, and 
reactions. 

Do you have any questions? 

http://www.techsmith.com/learn/morae/default.asp
http://www.techsmith.com/learn/morae/default.asp
http://www.techsmith.com/learn/morae/default.asp
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Scenario in Morae Configuration 

 Recorder > Modify Study Details button > Description tab 

Enter the scenario into the Study instructions field.  

 

Morae Scenario Tips 

 Use the Morae Add-In for Word to add the scenario to the test protocol (example in Appendix B: Test 
Protocol Document).  

 To avoid printing test paperwork for participants, you can test with AutoPilot to present the tasks onscreen 
to the participant. AutoPilot presents the scenario to the participant right on the computer screen. See 
AutoPilot in the Morae Recorder help for more information. 

For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Description > 
Study Instructions. 



Page 9 

 

3. Define Tasks 
The tasks should relate to real-life actions that fit the scenario. For more on how to create a scenario, see 
Usability Testing Basics, available on the Morae Resource CD and in the Morae Learning Center. 

For example, if we use the example scenario of ñYou have just purchased a new cell phone and want to 
personalize it,ò our first task is to change the ringtone. 

Tasks in Morae Configuration 

 Recorder > Modify Study Details button > Task Definitions tab 

For each task, enter a Name, Description, and Instructions for the participant.  

 

 Use the Morae Add-In for Word to add the tasks to the test protocol (example in Appendix B: Test 
Protocol Document) on the Task pages. Each task should be on a separate page so the participant 

can only see one task at a time. 

For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Tasks. 

http://www.techsmith.com/learn/morae/default.asp
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4. Define Markers 
After you have come up with the scenario and tasks, create the markers. Markers allow the Observers to flag 
specific, important points in a recording and the start and end of tasks as they happen. It is important to figure 
out what kinds of actions you want to define marker for because, by flagging important points during recording, 
you can save time when you later analyze the results.  

For example, mark:  

 Participant actions 

 Participant comments and questions 

 Participant frustration 

 Areas where a participant gets stuck 

 Application or web site design issues 

 Observations about how the participant performs a task 

 Interesting comments or actions to include in a highlight video  

 Moments when participantôs access Help, want to contact customer service or technical support  

You can also add notes to provide additional details for each marker. All the markers and notes are 
synchronized with the video and saved in the recording of each test session. 

Morae also includes the ability to score markers, for example 0 (severe) to 2( minor). Manager can 
automatically calculate the average severity of the errors.  

Markers in Morae Configuration 

 Recorder > Modify Study Details button > Marker Definitions tab 

In Morae, a marker definition includes a letter (keyboard shortcut for logging), text description, and color. 
Each study configuration template includes a default set of markers. The Hardware or Mobile Device Study 
template includes the following markers:  

Q ï Quote/comment X - Error 

H ï User needs help O- Observation 

P - Participant prompted V ï Video clip 

Use the provided default markers, modify the markers, or create new markers that match the goals of your 
study or identify specific things you want observers to watch for during a session. 

Morae Marker Tips 

 There is no correct number of markers. The object of logging markers during a test is to make it easier to 
analyze the test results.  

 If you have specific things you want to look for in a test, create a marker for that action, problem, etc.  

 Later when you analyze your sessions in Manager, markers help you sift through data and focus on what 
you want to analyze. For example, viewing all the Help requested markers may reveal an error where 
people are really struggling. 

 When you are ready to create video clips or a presentation for stakeholders, you save time by quickly 
going to the moments during the session that you marked to include in the highlight video. 
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 For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Markers. 

5. Define Surveys 
With surveys, you can collect information directly from the participants.  

To collect a participantôs survey responses, you can either ask the questions verbally and type the responses 
into the survey, have the participant take the survey on the computer running Recorder, or use the Morae 
Add-In for Word to print the surveys for the participant to fill in on paper. 

After you import recordings into Manager, you can view and compare responses, create graphs based on the 
surveys, and export results, including any freeform answers. 

Morae can open multiple surveys to participants during a session. For example, use a survey before the test, 
after each task, and after the test. 

The template study configuration includes surveys. Use or edit the surveys provided or create your own 
surveys.  

Surveys in Morae Configuration 

 Recorder > Modify Study Details button > Survey Definitions tab 

Create and associate surveys with session events, such as the end of a task. 
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Morae Survey Tips 

 Associate a survey with the beginning of recording, end of recording, or the end of each task. 

 By associating a survey with a session event, it is ñlinkedò to that event.  

Morae readies the survey associated with the current session event.  

 Use the Morae Add-In for Word to add the surveys to the test protocol (example in Appendix B: Test 
Protocol Document).  

 The System Usability Scale (SUS) is freely available for use in usability assessment and has been used 
for a variety of research projects; the only prerequisite for its use is that any published report must 
acknowledge the source of the measure. If you use the SUS, add the following to your report: 

ñSUS was developed as part of the usability engineering program in integrated office systems 
development at Digital Equipment Co Ltd., Reading, United Kingdom.ò 

For more information, in the Morae Recorder Help, see Define Study Details > Define the Study Surveys. 

6. Save Study Details 

 File > Save Study Configuration or click the Save Configuration icon. 

Study Details must be the same for all recordings in a study and include the items you have just defined: 

 Study name, description, and instructions 

 Tasks definitions and instructions 

 Marker definitions and instructions 

 Survey definitions and associations  

By saving the study configuration, and reusing that configuration, all recordings in a study have the same 
configuration and can be imported into the same study in Manager. 

7. Configure Recording Details 
Recording Details included in Morae study configurations define how to record the session, including the 
following: 

 File saving and processing options 

 Video sources 

 What data to capture 

 Who logs tasks 

 How to start and end test recordings 
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Recording Details in Morae Configuration 

 Recorder > Recording Details button  

The Recording Details of the template study configuration allow you to immediately conduct a recording. 

The Recording Details for the Hardware or Mobile Device Study template include: 

 Prompt for file saving details when recording stops 

 Record from a camera and include a Picture-in-Picture video from a second camera 

 Log tasks with the computer running Recorder  

 Start and stop recordings manually with Recorder 

 Allow Observers 

Morae Recording Details Tips 

 Recorder automatically chooses the source cameras for the main and PiP videos. Verify the selected 
sources are correct before recording. 

 If you change any Recording Details settings, the rest of the settings update to provide a valid or 
recommended configuration, if needed. 

 Recording Details are saved as part of the study configuration. While the Study Details must be the same 
for all recordings in a study, the Recording Details can vary in each recording. 

For more information, in the Morae Recorder Help, see Define Recording Details. 

8. Complete Test Set Up  
Study configuration is now complete. Here are the final things to do before you start testing. 

 Create Test Protocol 

 Finalize Morae Recorder Setup 

Create Test Protocol 

The test protocol is a document of everything needed for a test. There is an example protocol document in 
Appendix B: Test Protocol Document. Use this as a template to create the protocol for your test.  

 Test Session Setup Checklist 

 Release Form 

 Facilitator Script 

 Participant Instructions and Surveys 

 Assemble Participant Paperwork (Optional) 

 Email Invitations for Observers 
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Test Session Setup Checklist 

Verify the test setup is the same at the beginning of each test. A test setup checklist makes it easier to go 
from one test to the next as quickly as possible and make sure you do not miss anything. 

Make a list of all the things you need to do between tests and include it in test protocol document, such as: 

 Reset the mobile device to the default settings. 

 Clear the test area of any open documents, written notes, etc. 

 Prepare participant forms (release form, surveys, etc.) 

 Verify the cameras, camera angles, and lighting. 

Release Form 

A release form gives permission to record the test. Morae records the participantôs interactions with the 
hardware or mobile device with video and audio.  

If permission to record is denied, you may still conduct the test and take notes to use in reporting results, but 
you must not record the test session.  

If the contents of your test require the participant to keep session and product information confidential, include 
a non-disclosure agreement to your form. 

The example test protocol includes a sample release form that includes a non-disclosure agreement. 

Facilitator Script 

The facilitator script helps to explain the test session to the participant. The facilitator reads through the script 
at the beginning of each test session to ensure the participant understands what to expect during the test. 

Participant Instructions and Surveys 

Use the Morae Add-In for Word to put the scenario, tasks, and surveys into the protocol document. Open the 
study configuration in the add-in and drag the study and task instructions along with the surveys into the 
protocol. 

 

For more information, click the help button in the Morae Add-In for Word. 
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Assemble Participant Paperwork (Optional) 

Once you finish the protocol document, you need to assemble any paperwork needed for a test.  

If you are printing paperwork, each participant needs a copy of the following: 

 Release form 

 Background questionnaire 

 Scenario/session instructions 

 Tasks 

For the facilitator, print a copy of the protocol. In addition to the participant items listed above, the facilitator 
protocol includes the following: 

 Title page 

 Session setup checklist 

 Participant paperwork coversheet 

 Facilitator script 

 Task success paths (the best way or ways to complete a task) 

 List of debrief questions (follow up questions for the end of the test) 

See the example test protocol in Appendix B: Test Protocol Document for an example of complete protocol. 

Email Invitations for Observers 

Verify that all observers have Morae Observer installed on his or her computer. To make sure that all people 
that observe the test can connect to the session, send an email to each observer with the following 
information:  

 Name of test 

 Date of test 

 Time of test 

 IP address or name of Recorder computer 

 You may also want to include a list of the test tasks and markers to let the observers understand what 
they should watch for during the test. 

Finalize Morae Recorder Setup 

Prior to a Morae test, complete the following tasks: 

 Complete the Pre-recording Checklist 

 Run a Pilot Test Before Recording 
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Complete the Pre-recording Checklist 

The following checklist describes critical points that reduce the technical issues you may encounter and 
improve Moraeôs overall performance.  

Step Description 

Verify the system 
requirements 

Verify your system meets the recommended specifications to get the most efficient 
performance from Morae. For more information, see Morae System Requirements 
in the Morae Recorder Help. 

Verify you have 
enough hard drive 
space 

Recording file sizes may be approximately 10ï15 MB per minute, but the actual size 
varies depending on many factors. You should have extra space available for the 
best performance during recording.  

As a general rule, maintain 5ï10 GB of extra hard drive space as a buffer beyond 
what your Morae recording files use. 

 We recommend initially saving your recordings to a local hard drive to eliminate 
the chance of data loss that can occur when saving over a network or to an 
external device. After the file is saved, you can copy the recording file to an 
external device. 

Test your setup and 
scenario 

Test your setup before the actual recording session to resolve any possible 
complications (such as firewalls blocking Observer(s) from connecting, etc.).  

We recommend running a pilot recording for a short period of time to test Recorderôs 
start and stop options and to verify Observer(s) can connect. For more information, 
see Run a Pilot Test Before Recording. 

 In addition, use the Test Recording option in Recorder to create a 15 second 
recording to verify the screen, camera, and audio streams are being recorded 
properly. 

Verify Network 
Settings 

If Observer and Recorder are on the same Intranet, you do not need to disable 
firewalls. 

If they are not, verify that you either disabled any firewalls running on the Recorder 
or configured the firewalls to open the communication ports. See your network 
administrator for assistance.  

There are no firewall adjustments necessary on the Observer side.  

Open the study 
configuration in 
Recorder 

Open the saved study configuration in Recorder. 
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Run a Pilot Test Before Recording 

We recommend running a pilot test to verify Recorder is capturing data as expected. Conducting a short pilot 
recording helps you work out any network connectivity issues and test your automated start and stop options, 
if applicable.  

Follow these steps to run a pilot test: 

Step Notes 

1. Open a study configuration. In Recorder, open the study configuration (.mrcfg) for this 
study.  

2. Start Recorder. Click the Start button to start Recorder manually.  

3. Connect Observers to 
Recorder. 

Connect one or more Observers during the pilot test. 
Verify that you can successfully connect each to 
Recorder. 

4. Complete a test task. Run through one of the tasks. To test the logging 
functionality of Observer, have a team member practice 
setting markers while you complete the task.  

5. Stop Recorder. Either stop Recorder manually by clicking the Stop button 
in Recorder or use the keyboard shortcut <Ctrl + Alt + 
Shift + F9>.  

6. Import the recording and 
run a search. 

Save the test recording file and import it into a project in 
Manager. In Manager, verify the audio and video recorded 
correctly. Use the Search to verify markers were captured. 
See Analyze and Present Findings for more information 
on how to do this. 

 

05_Analyzing_recordings.doc
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Record and Log Test Sessions 
In this section, we discuss how to record and log test sessions. Everything in this section is done in Morae 
Recorder and Observer. Included in the section are the following: 

 Log Tasks on Recorder 

 Observers and Logging 

 Start and Stop the Recording 

 Log the Sessions 

 Send the Surveys 

 Save the Recording 

Log Tasks on Recorder 
When you record from one or two cameras with Recorder, you can log tasks and notes right on the computer 
running Recorder. This is the default task logger setting for camera only recordings.  

Observers and Logging 
Morae Observer connects to Recorder over a network and displays the full participantôs experience, including 
the screen, audio comments, and camera video. Each person using Observer can log markers, marker scores, 
and text notes that are sent back to the Recorder and saved with the recording file. 

By logging tasks, markers, and notes during the test session, you save time analyzing the recordings. In 
Manager, you can use the markers to pinpoint parts of the recordings you need to review, automatically 
create graphs, calculate marker scores, and more. 

Observers can connect prior to the beginning a recording, as long as Recorder is running. Observers do not 
see the participant interaction until recording begins. 

Benefits of Observer 

Although you can log sessions in a variety of ways, using Observer in combination with Recorder provides the 
following benefits: 

 Stakeholders can connect to watch live sessions without the need be in the room with the participant or 
an observation room. With Observer, stakeholders can connect from anywhere on the network. 

 Anyone logged into an Observer computer can add markers during recording complete with text notes. 

 Morae automatically collects and compiles everyoneôs notes. The recordings contain the markers and 
notes logged by all Observers.  

 Observer automatically saves and indexes the markers and tasks with the accompanying video and audio 
streams.  

 You can save a copy of the camera video and audio streams as a WMV file for immediate playback or to 
share with stakeholders. 

For information on connecting Observers to a recording, in the Morae Observer Help, see Connect to 
Recorder. 
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Start and Stop the Recording 
 The default way to start and stop recordings is to manually start and stop Recorder using the following 
buttons: 

  

Start Stop 

If this does not meet your needs, Morae provides flexible options to start Recorder depending on your 
equipment and participant set up.  

For more information, in the Morae Recorder Help, see Define Recording Details > Recording Start 
Settings and Define Recording Details > Recording Stop Settings.  

Log the Sessions 
Once recording starts, the facilitator prompts the participant to begin the test.  

The person working on the computer running Recorder along with each person using Observer can log 
markers, marker scores, and add text notes to save with the recording file. The person working on Recorder 
is designated as the task logger logs tasks and task scores.  

With both Recorder and Observer, you can save a copy of your markers and notes. Observers can also save 
a copy of the recording as a WMV file for immediate viewing.  

 

At the end of a session, the tasks and task scores are saved with the recording. You can view the 
synchronized video, audio, and notes for each marker later when you import the recording into Manager. 

By logging with Recorder and Observer during recording, you will save time analyzing the study in Manager. 
There should be no need to review entire recordings if you use Managerôs powerful search and graphing 
features to quickly analyze the recordings. 

The components used when logging in Recorder and Observer are: 
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For more information, in Morae Observer Help, see Log a Session. 

Send the Surveys 
Open surveys on the computer running Recorder anytime during the session. When the surveys open, you 
can ask the participants the questions and fill out the surveys, let the participant fill out the surveys on the 
computer running Recorder, or use the Morae Add-In for Word to print the surveys for the participant to fill in 
on paper. 

The person logging on the computer running Recorder and all Observers can access and deliver surveys.  

 In Recorder, choose View > Deliver Survey or use the keyboard shortcut <Ctrl + Alt + Shift + F8>. 

In Recorder or Observer, select and open surveys from the log. 
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Save the Recording 
By default, when recording stops, you are prompted for file details. Enter a name and description for the 
recording. If you want to start another recording right away, in Recording Details, choose to defer the 
processing of the recording. You can later batch process recordings. 

For additional options, in the Morae Recorder Help, see Define Recording Details > File Details > 
Processing. 

 You cannot save a recording without a name. You can lose the data from a recording if the test 
participant, or anyone else, closes the dialog prompting for these details after the recording stops. 

Analyze and Present Findings 
In this section, we discuss how to import recordings into Morae Manager, analyze data, create graphs, and 
create presentation materials for the test findings, including:  

1. Import Recordings 

2. Edit Recordings 

3. Analyze Recordings 

4. Graph  

5. Create Highlight Clips 

6. Create a Report 

1. Import Recordings 
To import recordings into Morae Manager, you first create a Morae project. Use a project to organize the 
recordings and studies in Manager.  

You can have multiple studies in a single project. The following are possible reasons to have multiple studies 
in a single Morae project: 

 You conduct the same test on different iterations of a product. 

 You conduct various tests on the same product. 

 You want to separate your studies by the experience level of participants. 

You can import a single recording into multiple projects. When you import a recording into a project, the 
original recording is not touched. A copy of the recording in imported into the project. Any changes you make 
to this copy do not affect the original recording. 

You can import Morae recording (.rdg), UserVue recording (.rdg) and standard video files (.avi, .wmv, .asf) 
into a project. 

For more information on importing recordings and creating projects, in the Morae Manager Help, see Create 
and Modify a Project > Create a New Project. 
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2. Edit Recordings 
View and edit the imported recordings in the Analyze Tab. In Manager: 

 Review the main camera video automatically synchronized with the Picture-in-Picture video and audio. 

 Create additional or edit the logged tasks, markers, notes, and scores. 

 Search across recordings in a study for specific markers. 

 View and edit survey answers. 

For information, in the Morae Manager Help, see Analyze. 

3. Analyze Recordings 
For information on what kinds of things to look for in the recordings, see How to Retrieve Your Key 
Measures from Morae. 

Managerôs Search allows you to quickly create custom searches to look for markers and tasks. 

You can use the pre-defined search profiles, define a new search, or create and save your own search 
profiles.  

 

06_Key%20Eval%20Measures.doc
06_Key%20Eval%20Measures.doc
06_Key%20Eval%20Measures.doc
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For more information, in the Morae Manager Help, see Analyze > Search for Data in Recordings. 

4. Graph Data, Tasks, Markers, and Surveys 
Instead of manually calculating data and building graphs, Morae creates graphs to help you share results 
faster, without manual calculations and scrubbing of data.  

Quantitative data provides hard evidence of usability issues, which complements the qualitative highlight 
videos. Highlight videos can be more powerful with graphs included to support the video clips. 

Morae automatically calculates and graphs the usability metrics specified in the Common Industry Format 
(CIF) standard ï effectiveness, efficiency, and satisfaction: 

 Measure effectiveness with error rate and completion rate graphs 

 Measure efficiency with a time on task graph  

 Measure satisfaction with a System Usability Scale (SUS) survey or customized survey delivered to 
participants at the end of the recording 
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Example Uses of Graphs 

Here are three examples of graphs you can create in the Morae Manager Present tab and the reasons why 
you might want to use these graphs. 

SUS Survey 
Graph 

   

Use this graph to measure satisfaction from a 
System Usability Scale (SUS) survey.  

SUS scores can range from 0 (very little 
satisfaction) to 100 (very high satisfaction). 

Survey 
Analysis  

SUS Survey 
Calculation 

Time on Task 
Graph 

   

Use this graph to measure efficiency.  

Efficiency is usually measured by determining how 
quickly participants are able to complete scenarios 
or tasks.  

Participants may be able to successfully complete 
an activity, but they take a long time.  

Task Analysis Time on Task 

Task Score 
Graph 

   

Use this graph to measure effectiveness by 
reviewing the completion rates for tasks. 
Effectiveness is a way of trying to understand better 
how successfully users will be able to use a site or 
software. This is usually measured by determining 
how many scenarios or tasks participants are able 
to complete. 

Task Analysis Task Score 

For more information, including more example graphs and uses, in the Morae Manager Help, see Graph > 
Graph Analysis Examples. 
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5. Create Highlight Clips 
When you are ready to organize the results of your analysis into a highlight video for presentation, select 
Managerôs Present tab. Use the Clip Bin and Storyboard to create, view, edit, and sort clips and graphs and 
assemble them into a video presentation. 

In the Present tab, assemble the important video clips, graphs and tasks into a highlight video to share with 
stakeholders. Include just the participantôs screen and audio in the highlight video or add a Picture-in-Picture 
(PiP) window showing the participantôs facial expressions. The highlight video can be produced in AVI, WMV, 
or MPEG-4 format. 

 


